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Introduction

C127 - Club Display Logger

The C127 comes standard as a combined 7" full colour display and powerful
control device that is readable in direct sunlight. With the addition of the Data
Logging upgrade it becomes a fully programmable data logger with 120 MB
memory (see Display Logger Upgrades).

Displayed channels, labels and colours are configurable on a diverse set of
supplied layouts; alternatively, use Display Creator software to create fully
configurable custom layouts. The C127 acquires data from devices such as
an ECU and displays data channels, warning alarms, lap times, fuel
calculations and much more.

Features

All MoTeC Displays come with a range of features as standard and several
options available as upgrades to customise and grow the system. These
additional features are activated through a simple password system, and can
be purchased at any time when you need them.

See Display Logger Upgrades.

General
e All-in-one display, logger (optional) and controller eliminates the need for
separate devices

e 16 full colour (RGB) LEDs; colour, function and intensity are fully
programmable

e Suitable for cars, marine and industrial applications
e Compact, durable and reliable unit

e Supports Wideband Lambda from MoTeC PLMs or LTCs, using Bosch
LSU or NTK UEGO 5 wire sensors

e Straightforward control for lights, fans, pumps (optional)

e Easily integrates with MoTeC CAN based products such as ECUs and
expanders. Full I/O expansion available with use of E888, E816.

e GPS Lap Timing

Logging and Analysis
e Optional internal data logging of 120 MB
e Fast download via Ethernet
e Data analysis with i2 Standard or optional i2 Pro software
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Accommodates over 300 channels derived from a mixture of analogue
and digital inputs, RS232 and CAN data channels

Configurable to use sensors from some existing engine management
systems

Display

High resolution 178 mm (7") anti-reflective colour LCD display, with high
brightness for sunlight readability

10 customisable layout options with diverse colour schemes, or
purchase the Display Creator software to create fully configurable
custom layouts.

Customisable measurement units and warnings

Configurable dial, sweep or bar graph can display any channel with
optional peak, hold and shift markers

48 user-defined alarms, e.g. Low Oil Pressure, Low Fuel, Fast Lap

Programmable overrides - particularly useful for showing values such as
lap times

Three programmable modes or 'pages’ with customisable labels ensure
the driver is shown only the most relevant information at any given time

Adjustable backlight

Software

Windows-based software designed for setup and management of the
display and data logging system

The user can generate a configuration file offline and send the
completed configuration to the Display Logger

Calculations including lap times, lap gain/loss, speed and distance, fuel
prediction

Monitor active channels—view all channels live

Sensor zeroing

Details editor including event, venue and vehicle details
Extensive Help screens

To access the newest software features you can download the latest
version from www.motec.com/downloads



http://www.motec.com/downloads
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Compatibility
e MoTeC ECUs: M4, M48, M8, M84, M400, M600, M800 and M880

e MoTeC accessories: E816, E888, SLM, PLM, LTC, BR2, PDM, GPS,
PDM, etc.

e Many non-MoTeC ECUs and other devices

Required Accessories
See to Connecting the Display Logger to a PC.
o #61225 Network Cable RJ45 1.5 Metre, or other standard ethernet cable

Optional Kits and Accessories
e Any one of the following:
0 18037 Race Display Kit
0 18038 Race Logging Kit
e 62204 C125 Race Loom Terminated
e 61259 C125 Input Loom
e 61197 OBD-II To Display Loom
e 61198 CAN ECU To Display Loom
e 61199 RS232 ECU To Display Loom
e 41304 GPS L10 10Hz
e 61221 Two Button Loom

System Overview

The Display Logger offers extensive possibilities to integrate with ECUs,
peripheral devices and accessories to form a complete solution that powers,
controls, logs, monitors and communicates virtually any automotive
parameter.

Typical devices used with the Display Logger

ECUs

The C127 Display Logger can be connected to all MoTeC engine
management systems and some other manufacturers' ECUs either via CAN,
RS232 or OBD-II. This avoids duplication of sensors and allows the Display
Logger to display and log many ECU parameters.

The typical update rate is about 20 times per second for RS232 and 50 times
per second for CAN, but is less from OBD-II.
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Sensors

The optional Display Logger inputs* can be connected to a wide variety of
sensors. Different types of sensors are available to suit different types of
measurements, for example: temperature, pressure, movement etc.

Sensors convert a physical measurement (e.g. pressure) into an electrical
signal (e.g. volts).

Different types of sensors generate different types of electrical signals. For
example, most temperature sensors convert the temperature into a variable
resistance which may be measured by an Analogue Temperature input.
However most wheel speed sensors generate a variable frequency signal
which must be connected to either a Digital input or a Speed input.

*To use these inputs, you will need to add the #29800 C127 1/O enable.
Expanders

E888/E816

The C127 fully supports two E888 or E816 Expanders allowing expansion
of the number of inputs and outputs

Accessories

BR2

A BR2 Beacon Receiver may be connected to the C127, which allows the
Display Logger to calculate lap times for display and to provide lap
information for the data analysis software.

SLM-C
The SLM-C Club Shift Light Module can be used for shift lights, warning
lights and other driver alerts.

The SLM-C includes 8 coloured LEDs that can be programmed to display
in a pre-defined pattern.

GPS

The C127 Display Logger supports many GPS (Global Positioning
System) devices allowing it to record speed and position information as
well as providing lap timing.

This information can be used in the i2 data analysis software to create
track maps, and plot and compare driven lines.

A 10 Hz GPS is supplied as part of the C127 Race Kits.
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High Definition Video

MoTeC brings true high definition to motorsport with its new HD Video
Capture System. The HD-VCS provides superior quality video and
numerous features designed specifically for the racing environment.

Features include:
e Genuine High Definition with 1080p @ 30 frames per second

e Automatic Start/Stop, eliminating the possibility of drivers forgetting to
turn it on

e 12V power direct from the vehicle - no batteries to recharge

e Live gauges automatically recorded on the video

e Over 5 hours of recording at 1080p

e Records to removable storage up to 32 GB

e Video can be played directly from the card

e Automatic CAN Synchronisation with data in i2 (available late 2013)
e Compact, lightweight recording unit

Lambda Measurement

PLM

The PLM Professional Lambda Meter measures the air fuel ratio over a
wide range of mixtures with fast response time. It is compatible with Bosch
LSU and NTK UEGO Lambda sensors and displays the Lambda readings
via the integrated display.

LTC/LTCD/LTC NTK

LTC Lambda to CAN modules provide accurate Lambda measurements
even when the exhaust gas temperature changes rapidly. They are
compatible with the Bosch LSU 4.9/ NTK Lambda sensors and transmit
Lambda readings via the CAN bus.

Remote Displays

A remote display device may be connected to the C127 to allow display of any
value that the Display Logger calculates, such as lap times and warning alarm
messages.

The Club Display Logger supports D153, D175 displays which are connected
via CAN.


http://www.motec.com.au/hdvcs/hdvcsgauges
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PDMs

Power Distribution Modules are designed to replace conventional relays,
fuses and circuit breakers by providing electronically switched power to the
various electrical systems in the vehicle. This simplifies wiring and switch
requirements, while increasing reliability.

Full diagnostic information, including output currents and error status, can be
transmitted via CAN to the Display Logger.

Several models are available to suit vehicles with different complexity ranging
from 15 to 32 outputs and 12 to 23 inputs.

Other Devices
Many other devices can be connected to the C127 Display Logger.
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C127 Race Kits

C127 Race Display Kit

The C127 Race Display Kit is a complete plug and play solution. All wires are
labelled and terminated, ensuring a fast, easy installation.

The Race Display Kit will allow you to perform the following functions and
more with your C127:

e Laptiming

e Shift lights

e Warnings

e Multiple page layouts

e ECU connection

o Display of sensor values

Kit contents:
e 18036 —C127 COLOUR DISPLAY LOGGER
e 61260 — C125 ACCESSORY KIT containing:

o

o
o
o

41304 — GPS L10 10Hz
61221 - TWO BUTTON LOOM
61225 - NETWORK CABLE RJ45 1.5 METRE

62204 — C125 RACE LOOM TERMINATED (this loom is used on
both the C125 and C127)

C127 Race Logging Kit

The Race Logging Kit is a complete plug and play solution with data logging.
All wires are labelled and terminated, ensuring a fast, easy installation.

The Race Logging Kit will allow you to perform the following functions and
more with your C127:

e Laptiming

e Track Mapping

e Data Logging

e Shift lights

e Warnings

e Multiple page layouts
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e ECU connection

e Display of sensor values

e Driver analysis

e Engine performance measurement

e Data analysis using MoTeC'’s i2 software

Kit contents:

e 18036 — C127 COLOUR DISPLAY LOGGER

e 29818 —C127 120 MB LOGGING

e 61260 — C125 ACCESSORY KIT containing:
0 41304 — GPS L10 10Hz
0 61221 - TWO BUTTON LOOM
0 61225 - NETWORK CABLE RJ45 1.5 METRE
o]

62204 — C125 RACE LOOM TERMINATED (this loom is
used on both the C125 and C127)

Installing the C125 Terminated Loom

This loom is used on both the C125 and C127

The C127 has an optional terminated loom that is pre-configured to get the
most out of your Display Logger. This loom plugs directly into the back of the
C127, and has labelled wires for each of the parts that come with the Race
Kit. The loom has these connections:

e Power - Connectto a 12 - 32 V power source and ground with a 5
ampere fuse. When using the C127 Race kits, use the cigarette
lighter adapter.

e GPS - Ensure that you connect a compatible 5V GPS unit only to the
lead labelled “GPS”. Plugging a GPS into the Accessories lead will
damage the GPS.

e Buttons - Plug in the button loom as supplied with the kit for Mode,
Alarm Acknowledge and Next Line functionality.

e Accessories — Use this lead to connect a MoTeC CAN based
product to the C127, such as LTC, expander, HD-VCS

e ECU - ECU communications are sent to the C127 via this connector.
Terminated looms are available for OBD-II, M84, MoTeC ‘Hundred
Series’ ECUs and RS232 (M4, M48 and other brands).

e Ethernet - For communications between your Dash and a PC for
configuration.
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Installing the C125 Input Loom

The C125 Input loom is a fast way to add sensors to your C127 when you
have added the 1/0O upgrade. Following these instructions, you can quickly
add wiring for 6 AVs, 2 ATs, 2 Digital and 3 Speed inputs to your vehicle’s
loom.

Installation Process

1. Connect DTM 4 pin male of the Input loom to GPS DTM 4 pin female
connector of the main loom.

2. Connect DTM 4 pin female connector of the Input loom to the GPS
connector. The purpose of this connection is to supply 5V and 0 V to the
Sensors.

. Remove the main 34 pin C127 connector from the back of the C127.
. Unlock the C127 connector by pushing in the long white locking tab.
. Remove white plugs from pins 3, 4, 5, 6, 12, 13, 16, 17.

. Insert pinned wires into the C127 connector as follows:

o 01 b~ W

e AV1 — blue wire into pin location 3

e AV2 — green wire into pin location 4

e AV3 — purple wire into pin location 5

e AV4 — grey wire into pin location 6

e AV5 — yellow wire into pin location 12
e AV6 — white wire into pin location 13
e AT1 — brown wire into pin location 16
e AT2 — orange wire into pin location 17

7. Secure the pins in place by pushing in the two locking tabs on the C127
connector. If the two locking tabs are difficult to push back, this indicates
that one of the inserted pins is not seated correctly.

8. Run the AV and AT wires to the locations required for your new sensors.

Notes:
e The red wires are 5V
e The black wires are 0 V
e Coloured wires are the AV and AT wires
e You can shorten the looms as required by cutting them shorter
e You should loop and tie up unused looms for future use
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Installing the OBD-Il To Display Loom

The OBD-Il loom is a terminated adapter that joins the C125 terminated loom
(#62204) to the standard on-board diagnostics port on most road cars 2007 or
later.

There is no standard location for the OBD-II socket in a road car, so you will
have to search your vehicle to find its location. The most common place is in
the driver’s foot well, under the dash panel. In some instances it is directly
accessible, other times you may need to remove a covering panel.

Installation method — if C127 came pre-configured

1. Plug in the C127, buttons and GPS. DO NOT connect the OBD-Il To
Display Loom at this stage.

2. Plug the cigarette lighter power adapter into a spare power supply socket.

3. Press and hold the red button on the button loom for at least 5 seconds. If
correctly configured, “OBD-II” will display on the C127. NOTE: If “OBD-II”
does not display, do not plug in the OBD-Il To Display Loom and follow the
NOT pre-configured instructions.

4. Plug the 4 pin DTMF connector into the connector labelled ECU.
. Find the OBD-II connector and plug in the mating connector.
6. Start the car. Installation should now be complete.

o1

Installation method — if C127 is NOT pre-configured

1. Plug in the C127, buttons and GPS. DO NOT connect the OBD-Il To
Display Loom at this stage.

. Plug the cigarette lighter power adapter into a spare power supply socket
. Connect a laptop to the C127 using the provided Ethernet lead
. Start up C127 Dash Manager

. Select Tools > Connection settings in C127 Dash Manager, then select
Add

. Select the Search button

7. Highlight the device displayed in the connected device window, and select
the Select button

8. Select OK on the new IP screen

9. Select OK on the Connection settings screen
10. Select File > New

11. Select C127 OBD2 configuration

a b~ WDN

o
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12. Select Online > Send Configuration to put the OBD-II configuration in
the Dash

13. Save the file with a new name, such as “my start file”

14. Choose Yes, or Ok to any warnings that display while this new
configuration is sent to the Dash.

15. Press and hold the red button on the button loom for at least 5 seconds. If
correctly configured, “OBD-II" will display on the C127. NOTE: If “OBD-II”
does not display, do not plug in the OBD-Il To Display Loom and contact
your dealer.

16. Plug the 4 pin DTMF connector into the connector labelled ECU.
17. Find the OBD-II connector and plug in the mating connector.
18. Start the car. Installation should now be complete.

Installing the CAN ECU To Display Loom

The CAN ECU To Display Loom connects the C125 loom to a MoTeC CAN
ECU via the CAN communications connector.

NOTE: The CAN communications connector is the socket that you would
normally use to connect a UTC to your ECU for tuning.

Installation method — if C127 came pre-configured
1. Plug in the C127, buttons and GPS.

2. Connect the C125 to CAN ECU adapter loom to the ECU plug on your
C125 loom. Plug the other end into your ECU communications connector.

3. Plug the cigarette lighter power adapter into a spare power supply socket. If
your vehicle does not have a power supply socket, cut off the adapter and
connect the red wire to a fused 12 V source and the black wire to chassis
ground.

4. Power up the car, including turning on the MoTeC ECU. The number in the
top right of the display should change to show the current Engine
Temperature. NOTE: If the Engine Temperature is not displayed, then
either your ECU or C127 isn’t correctly configured. Follow the not pre-
configured instructions.

5. The installation should now be complete.

Installation method — if C127 is NOT pre-configured
1. Plug in the C127, buttons and GPS.
2. Connect the C125 to CAN ECU adapter loom to the ECU plug on your
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C125 loom. Plug the other end into your ECU communications connector.

3. Plug the cigarette lighter power adapter into a spare power supply socket. If
your vehicle does not have a power supply socket, cut off the adapter and
connect the red wire to a fused 12 V source and the black wire to chassis
ground.

4. Connect a laptop to the C127 using the Ethernet lead provided.
5. Start up C127 Dash Manager.

6. Select Tools > Connection settings in C127 Dash Manager, then select
Add.

7. Select the Search button.

8. Highlight the device displayed in the connected device window, and select
the Select button.

9. Select OK on the new IP screen.
10. Select OK on the Connection settings screen.
11. Select File > New

12. Select C127 M400 M600 M800 template if you have one of those ECUs,
or select the C127 M84 template.

13. Select Online > Send Configuration to put the configuration in the Dash
14. Save the file with a new name, such as “my start file”

15. Choose yes or ok to any warnings that display while this new
configuration is sent to the Dash.

16. Power up the car, including turning on the MoTeC ECU. The number in
the top right of the display should change to show the current Engine
Temperature. NOTE: If the Engine Temperature is still not displayed, check
ECU settings as shown below.

17. The installation should now be complete.

ECU settings

Start ECU manager, and connect your UTC.

Select Adjust > General setup > Communications > CAN Setup
Set CAN 0 Data to O

Set CAN 0 Address to 1520

Set CAN 0 Transfer Rate to 50
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Installing the RS232 ECU To Display Loom

The RS232 ECU To Display Loom connects the C125 loom to an ECU via its
RS232 communications connector.

NOTE: The RS232 communications connector is the socket that you would
normally use to connect to your ECU for tuning.

Installation method — if C127 came pre-configured

1.
2.

Plug in the C127, buttons and GPS.

Connect the C125 to RS232 ECU adapter loom to the ECU plug on your
C125 loom. Plug the other end into your ECU communications connector.
An additional cable/adapter may be required in conjunction with the RS232
adapter for some ECU'’s.

. Plug the cigarette lighter power adapter into a spare power supply socket. If

your vehicle does not have a power supply socket, cut off the adapter and
connect the red wire to a fused 12 V source and the black wire to chassis
ground.

. Power up the car, including turning on the ECU. The number in the top right

of the display should change to show the current Engine Temperature.
NOTE: If the Engine Temperature is not displayed, then either your ECU or
C127 isn't correctly configured. Follow the not pre-configured instructions.

. The installation should now be complete.

Installation method — if C127 is NOT pre-configured

1.
2.

&)

Plug in the C127, buttons and GPS.

Connect the C125 to RS232 ECU adapter loom to the ECU plug on your
C125 loom. Plug the other end into your ECU communications connector.
An additional cable/adapter may be required in conjunction with the RS232
adapter for some ECU’s.

. Plug the cigarette lighter power adapter into a spare power supply socket. If

your vehicle does not have a power supply socket, cut off the adapter and
connect the red wire to a fused 12 V source and the black wire to chassis
ground.

. Connect a laptop to the C127 using the Ethernet lead provided.
. Start up C127 Dash Manager.
. Select Tools > Connection settings in C127 Dash Manager, then select

Add.

. Select the Search button.
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8. Highlight the device displayed in the connected device window, and select
the Select button.

9. Select OK on the new IP screen.
10. Select OK on the Connection settings screen.
11. Select File > New

12. Select C127 M4 M48 template if you have one of those ECUs. Other
ECUs will require a custom template.

13. Select Online > Send Configuration to put the configuration in the Dash.
14. Save the file with a new name, such as “my start file”

15. Choose yes or ok to any warnings that display while this new
configuration is sent to the Dash.

16. Power up the car, including turning on the ECU. The number in the top
right of the display should change to show the current Engine Temperature.
NOTE: If the Engine Temperature is still not displayed, check ECU
settings, as shown below.

17. The installation should now be complete.

ECU settings

Start M4/M48/M8 ECU Manager and connect the laptop.
Select Adjust > General setup > Miscellaneous Setup 2
Set Telemetry Baud Rate to 19201

Set Telemetry Data Setto 5
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Installation

This section provides information on how to install the Display Logger in the
vehicle and connect it to other devices. It will also provide information on how
to install the software.

Mounting and Wiring

The Display Logger has three threaded mounting posts. For further details
see Mounting Dimensions.

Mounting Tips

e Avoid twisting the case: use washers between the unit and the mounting
panel to ensure that the unit is mounted only at the mounting points and
do not over tighten the mounting screws.

e Vibration isolation may be desirable if the vehicle vibrates severely.
e Mount so that the connector may be easily accessed.

e Orientation: for best contrast, the display should be viewed at an angle
of approximately 20 degrees, however the Display Logger will provide
good contrast between 0 and 40 degrees. Display reflections should also
be considered when determining the mounting angle.

&

20°

The C127 uses a 34 pin connector. See Connector and C127 Pin List by
Eunction for full details.

Wiring Tips
e To ensure that the connector is sealed, plug unused holes with filler
plugs.

o Use 22# Tefzel wire (Mil Spec M22759/16-22) (5 A max at 100 0C)
o Tefzel wire is difficult to strip unless the correct stripping tool is used.

e Be careful not to nick the wires as this may result in wire failure or poor
crimping.
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e Some sensor connectors may not be available with 22# terminals, in
which case doubling the wire over gives the equivalent of an 18# wire.
This is suitable for many of the common sensor terminals.

e Use the correct crimping tool for all contacts to ensure a reliable
connection.

e Power the Display Logger via a separate switch and a 5 ampere fuse, to
ensure the PC can communicate with the Display Logger without the
need to power the rest of the vehicle.

e The C127 ground must have a direct connection to the vehicle battery.
e The Display Logger is connected to other devices via the CAN bus.

Connecting Devices

Peripheral devices can be directly connected to the Display Logger's input
and output pins. The Display Logger can also send or receive data from other
devices via either RS232 or CAN communications.

Inputs — Requires I/O Upgrade

Input Types

A range of sensors is available to suit different types of measurement, e.g.
temperatures, pressures, speed. Each type of measurement generates a
different electrical signal that requires a suitable input type.

Each sensor needs to be connected to the type of input designed to suit that
type of sensor.
MoTeC devices have the following input types available:

e Analogue Voltage Inputs

e Analogue Temperature Inputs

o Digital Inputs

e Wheel Speed Inputs

In addition to sensors connected to the inputs, the Display Logger has internal
sensors available for battery voltage, device temperature and G-force.

Analogue Voltage Inputs

Analogue Voltage inputs are normally used to measure the signals from
analogue voltage type sensors, i.e. sensors with variable voltage outputs,
such as:

o Rotary or linear potentiometers
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0 Signal conditioned three-wire pressure sensors
0 Thermocouple amplifiers
0 Accelerometers

These inputs can also be used to measure two-wire variable resistance
sensors if an external pull-up resistor is connected from the input to the
5V sensor supply.

Additionally, on/off switch signals may be connected, which may also
require an external pull-up resistor.

Analogue Temp Inputs

Analogue Temperature inputs are identical to Analogue Voltage inputs,
except that they contain a 1000 ohm resistor which is connected internally
from the input pin to the 5 V sensor supply. This allows the Analogue
Temperature inputs to be used with two-wire variable resistance sensors,
such as:

0 Two wire thermistor temperature sensors
0 Two wire variable resistance pressure sensors

Some voltage output sensors can also be used if they can drive the 1000
ohm resistor without causing an error in their reading (e.g. MoTeC
Thermocouple Amplifier).

Additionally, on/off switch signals may be connected.

Digital Inputs

Digital inputs can be used for the external switches required to operate the
display. These inputs have a 4700 ohm resistor connected internally from
the input pin to the 5 V sensor supply so that a switch can be simply
connected between the input pin and 0 V.

They can also be connected to a brake switch or other switch.

Digital Inputs include the following measurement methods:

o Frequency: The frequency of the input signal is measured

Period: The time between successive pulses is measured

Pulse width: The low time of the pulse is measured

Count: Counts the number of pulses

Phase Difference: Calculates the phase difference between two digital
inputs

0 Beacon: For connection of a lap beacon

O O O O
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Speed Inputs

Speed Inputs are identical to Digital Inputs except that they can also be
configured to suit Variable Reluctance (Magnetic) sensors, such as some
wheel speed sensors. Because the amplitude of the signal from these
sensors changes with speed of rotation, variable trigger levels are
required, which must vary with the frequency of the input signal.

The Speed Inputs can also be used with Hall Effect type wheel speed
Sensors.

The Pulse Width method measures the high time of the pulse rather than
the low time as measured by the Digital Inputs.

Input Specifications
For full specifications see Input Characteristics.

Expanders

If additional sensors are required, input expanders can be used, such as
MoTeC’s E816 and E888. Sensors can be connected to the expander inputs
and communicate via either RS232 or CAN. See Configuring
Communications.

Outputs — Requires 1/0 Upgrade

Auxiliary Outputs are used to control various vehicle functions, for example:
0 Gear Change Lights
o Warning Lights
0 Relays controlling Thermatic Fans and Pumps etc.

Note: Devices that consume more than the maximum current (e.g. motors)
should be driven via a relay or a MoTeC PDM (Power Distribution Module).

Output Specifications
Full specifications can be found in Output Characteristics.

Expanders

If additional outputs are required, output expanders can be used, e.g. PDM.
Expander outputs can perform the same tasks as the device outputs and can
be driven by communication via either RS232 or CAN. See Configuring
Communications.
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Communications

Communications are used to send and receive data from one device to
another. There are two communication protocols: RS232 and CAN. Generally
older devices use RS232 and newer devices use CAN.

CAN (Controller Area Network) Communications

This protocol enables communication between all devices connected to the
same bus. The CAN bus allows for communicating at high speeds. The C127
has two independent CAN communications ports that can be connected to
other devices with a compatible CAN port. The bus speed for each interface
can be set independently.

Typical MoTeC devices communicating over CAN:
0 M84 and 'Hundred Series' ECUs: M400, M600, M800, M880
Shift Light Module: SLM
Lambda meters: LTCs, PLM
Expanders and input modules: E888, PDM
Displays: SDL3
0 Beacon receiver: BR2

These devices communicate at 1 Mbit/sec, so any other devices connected
on the CAN bus must also communicate at 1 Mbit/sec. If a device
communicates at another speed, it should be wired to the other CAN bus, and
the speed of that CAN bus must be set to match the speed of the device.

O ©0 O ©o

RS232 Serial Communications

This is a one to one protocol, communicating from one device to one other
device. Typical devices communicating over RS232:

0 MoTeC M4, M48 ECUs
0 Radio telemetry device
0 Global positioning system: GPS

Note: The Display Logger can only communicate with devices for which it has
the appropriate communications protocol defined.
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Connecting Devices Examples

Device Connect via Remarks

Sensors Inputs: MoTeC supplies datasheets

The appropriate input
type depends on the
sensor type

with wiring details for all
sensors via the website

External Buttons for:
- Display mode

- Display next line
(and optional
previous line)

- Alarm acknowledge
- Lap number reset

Inputs:
Digital or Speed inputs

Wire between Display
Logger input and Display
Logger O V.

If wired to an Analogue
Voltage input, connect an
external pull-up resistor
between the input pin and
the 5V sensor supply.

External LED Lights

Outputs:
Auxiliary output

Wire between one of the
Auxiliary Outputs and battery
positive and include a
current limiting resistor.

SLM Shift Light
Module

Communications:
CAN

K-type
Thermocouples

Inputs:

Analogue Voltage or
Analogue Temperature
input

Connect via TCA (Thermo
Couple Amplifier)

Communications:
CAN

Connect via E888

ECU M4, M48, M8

Communications:
RS232

Uses the Telemetry feature
of the ECU to send data to
the Display Logger

ECU M84, 'Hundred
Series': M400, M600,
M800, M880

Communications:
CAN

Ensure the ECU and Display
Logger are connected on the
same CAN bus
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Software Installation

This section provides information on Dash Manager software, and i2 Data
Analysis software.

It will also explain how to connect the Display Logger to the PC.

PC Recommendations

MoTeC recommends a dedicated laptop for your race car with the following
specifications:

e Windows XP, Vista or Windows 7, Windows 8

e Screen size: 1024 x 768

e Processor speed: 1-2 GHz Pentium

e 2GBRAM

e 256 MB graphics card

e 2 USB ports

e Ethernet port
Most current laptops will meet the specifications above and this will ensure all
MoTeC software will run on it.

C127 Dash Manager Software

C127 Dash Manager software is used for configuration, testing, retrieving the
logged data, and for general management of the Club Display Logger.

C127 Dash Manager supports configuration of the following connected
devices: E816, E888, SLM.

Installing Dash Manager Software

1. Go tothe MoTeC website at www.motec.com and navigate to
software/latestreleases/C127 Dash Manager software

OR

Locate the Dash Manager software on the MoTeC Resource Disc
Save the selected file in your preferred location (for example desktop)
When downloading is finished, double click on the file and select run
Follow the instructions on the InstallShield Wizard

To start the program after installation, click the C127 Dash Manager
icon on the desktop or click Start > All Programs > MoTeC > C127 >
C127 Dash Manager

a s wDd
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Updating C127 Dash Manager Software

Software updates are available free of charge, giving access to the latest
features. Download the latest software version from the website and follow the
software installation instructions to update to the new version.

To update the associated firmware in the device, select Upgrade Dash
Version from the Online menu. See Configuration Versions and Updating.

i2 Data Analysis Software

MoTeC's i2 data analysis software is used to analyse the logged data that has
been recorded by the Display Logger. Any number and combination of
graphs, gauges and reports can be analysed simultaneously. The i2
environment can be customised to specific user requirements.

i2 Standard is included with any Data Logging upgrade.

Connecting the Display Logger to a PC

The Display Logger connects to the Ethernet port on the PC. This requires a
connector for the standard Ethernet cable in the loom.

The C125 RACE LOOM TERMINATED #62204 incorporates this connector.
Alternatively the connector can be wired into an existing loom using the
unterminated Ethernet cable (#61131), or the Ethernet to Superseal
Connector Cable that is terminated with Tyco connector pins (#61236).

All options are used in conjunction with a standard Ethernet cable.
Connection details are described in PC Connection

PC Communications Setup

To enable PC communications, a connection must be setup in the Dash
Manager software to match the Display Logger serial number.

e Onthe Tools menu click Connection Settings and then click Add

e Click OK to choose IP (Ethernet). This is the only available connection
type.

e Click Search*

¢ In the list with discovered devices, click the required Display Logger
and click Select
If the PC needs to communicate with more than one Display Logger, repeat
the steps.
* The connection uses IPV6, which can be affected by firewall and anti
virus applications.

If you have a Display Logger connected but it is not listed in Discovered
Devices, try disabling or uninstalling all anti-virus software.
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If the Device is 'discovered' without the anti-virus software, you can turn it
back on and put in appropriate exceptions to allow the Display Logger
Manager to communicate with the device.

Only one connection can be active at a time. To switch to a different Display
Logger, click Make Active.

Tip: The current connection is listed at the bottom of the Dash Manager
splash screen (this is the main Dash Manager screen with the picture of the
Logger)

For a quick way to switch between connections

¢ In the Dash Manager splash screen, enter the connection number
(to enter the splash screen, close all other windows in Dash Manager).
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Configuration

All aspects of the Display Logger can be configured, including; which sensor
is connected to which input, the calibration of each sensor, what to display
and where to display it, what to log and how fast to log it, tacho range,
warning alarms, multi stage shift lights etc.

The configuration is stored in a file on the PC. When starting Dash Manager
software, the menu items related to changing the configuration are
unavailable. To make them available, load a configuration file either by
opening an existing file or by creating a new one.

All changes to the Display Logger configuration are performed ‘Offline’, i.e.
without the PC communicating with the Display Logger. The changes are
saved in the configuration file on the PC. The file must be sent to the Display
Logger before the changes take effect. See Sending and Retrieving
Configuration Files.

Tip: When using a laptop in and around a catr, it is often not practical to use a
mouse to navigate through the program. Using the keyboard to select options
is easier. An overview is given in Windows Keyboard Shortcuts.

Configuration Sequence

The configuration is best setup in the following order:
1. Connections (Input Pins & Communications)
2. Calculations (Lap Time, Fuel Prediction etc.)
3. Functions (Logging, Display, Alarms, Auxiliary Outputs etc.)

This simplifies the setup procedure by ensuring that the required channels are
available for the functions that use them.

Channels cannot be used until they have been generated by an input,
calculation or function.

Configuration File

From the File menu the following options are available:

e New — creates a new configuration based on a predefined template

e Open - selects an existing file
Right-click the configuration file to Rename, Delete, Send to a disk etc.

e Save — saves a newly created configuration with a meaningful name

e Save as — can be used to create a copy of an existing configuration file
by giving it a new name



30 Configuration MoTeC

o Edit Details — allows for entering event, venue and vehicle details to be
stored with the configuration file

e Check Channels — verifies that all channels are correctly generated

e Edit Configuration Comments — allows for other comments to be
stored with the configuration file

e View Configuration Summary — gives a quick overview of the
configuration file

e Convert Logging Image — allows users to manually convert a log file for
useini2

e EXit — exits the program

Tip: The most recently used files appear at the bottom of the File menu. This
is often the easiest way to open an existing file.

Backups

Whenever a file is saved, the previous content of the file is saved in the Save
Backups directory. The total number of files is limited to 100.

Channels

Channels are used to convey information between the various systems of the
Display Logger.

For example an input pin may feed a channel called ‘Fuel Pressure’.
This channel may then be used by another system, such as the Display
System or Data Logging systems.

The Display Logger channel scheme allows complete flexibility in channel
usage, as any available channel can be used by any other function, i.e. any
channel can be logged, displayed, used in conditions, used in alarms, used as
an input to the user definable tables, etc.

All systems within the Display Logger that generate values must feed one of
the channels.

Pre-defined Channels
MoTeC has defined an extensive list of channels.

General Purpose Channels

Since the use of all channels cannot be predetermined, a number of general
purpose channels have been included for occasions when a suitable
predefined channel is not available.
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These general purpose channels may be required when measuring an
uncommon value, or when a general purpose function needs to generate a
special output channel. For example, a 3D table may generate an output
channel to control a valve of some sort, in which case a general purpose
channel may be used and named appropriately.

Channel Connection Example

Sensors

58 %

Analog| | Speed | [RS232
Inputs | | Inputs | [Comms
l ® Data
L d » Logging Logging
VK 1 »| System ™ Memory
* 4
L >
* »| Display LCD
® L E System » Displa}f
[ »
P . Alarm
[ System ]
[
Gear
' .
o » Detection [
== 2l1= <
AHIRIEIE
il Wl [ 3 j.',' _ | Auxiliary _| warning
g ol IB11B] =] 18] € * Qutputs ™ Light
= E =
AL
gzl |a|lallx| =] |2
o=zl Bl EIEl [E] |
o= [E] €] 12] [B] =] |8
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Channels
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Channel Properties

Each channel has defined properties, some of which may be modified by the
user. Predefining these properties makes the channels easy to use
throughout the rest of the software.

e Properties that may be modified by the user

o Name
The channel names (and abbreviations) may be changed if necessary.
However name changes should be limited to name preferences rather
than redefining the purpose of the channel, except for the general
purpose channels which may be renamed to suit the current use.

o0 Abbreviation

0 Units (e.g. degrees Celsius, degrees Fahrenheit)
The units for a channel can be selected from a predefined list, for
example the Engine Temperature channel may have units of degrees
Celsius, Fahrenheit or Kelvin. Conversion between units is
automatically handled by the software.
Note: The units are used for display purposes only. This means that
the units can be changed at any time without affecting the calibration of
the channel.

o Fixed properties

0 Measurement type (e.g. Temperature)
Defining the measurement type allows the channels to be displayed in
any unit suitable for that type, with automatic conversion between the
units. For example all temperature channels can be displayed in
degrees Celsius, Fahrenheit or Kelvin.

0 Resolution
The resolution of all channels is fixed, for example the resolution of the
Engine Temperature channel is fixed at 0.1 °C.
Fixed channel resolutions ensure that the unit conversion system
works properly and that channel comparisons can be performed
correctly.

Suitable logging rates
Suitable display filtering
Minimum and maximum range
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Selecting Channels

There are two methods of selecting channels, either the Category Method or
the Search Method.

Category Method

This method divides all the channels into categories and sub categories, so
that the list can be narrowed down to a small list of channels. For example,
the ‘Engine Sensors / Cooling’ category shows a list of channels associated
with the cooling system of the engine.

When selecting a channel from the complete list of channels, it is usually
easiest to use the category selection method, for example when assigning a
channel to an input pin.

To expand a category
o click on the plus sign (+) next to the category name.

Carrian [Enaine]
Air

Air Fuel Ratio
Antidetonant

Engine Temp
Engine Coolant Terp - Pos 2

Engine Coolant Temp - Pos 3
Engine Coolant Lewvel

Engine Coolant Flaw Fate
Engine Coolant Pres - System
Engine Coolant Pres - PumpQut
Engine Conlant Pres - Pump In
Head Temperature 1

Head Temperature 2

Head Temperature 3
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Search Method

This method lists all channels in alphabetical order and allows a channel to be
found either by typing the first few letters of any word in the channel name, or
by scrolling through the list.

Note: The words may be typed out of order so that ‘Engine Oil Temp’ could
be found by typing "temp eng oil" or "oil t eng" or "e 0 t”
This method is most useful when selecting a channel from the available
channels.
For example, if ‘Engine Temperature’ has been assigned to an input pin, it
can be easily located in the Search list, since this list normally only
contains 50 to 100 items.

Engine Oil Temp - Coaler In
Engine Oil Temp - Coaoler Qut
Maw Engine Ol Temp

Min Engine Ol Temp
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Connections

Configuring Inputs (optional)

On the Connections menu, click Devices

Select the device (e.g. C127) and then click the Input Pins tab
This will list all inputs available for this product

Select the input and click Channel (or double-click the input)
Assign a measurement channel to the input and click OK

The channel needs to be calibrated using one of two options:
Select Load Cal if a pre-defined calibration is available

OR

Double-click the input to enter a calibration

Other tasks:
e Change Cal —to change the calibration
e Spd Levels —only for speed inputs
e Settings — to set default

Configuring Outputs (optional)

1. Onthe Connections menu, click Devices

2. Select device (e.g. C127) and then click the Output Pins tab to list all

outputs available for this product

3. Select the output and click Change (or double-click the output)

4. Select a mode to make appropriate settings available

5. Follow the directions on the screen and when all settings are done

click OK

Configuring Communications

1. Onthe Connections menu, click Communications

2. Select an available communications section (CAN or RS232)
3. Click Select and choose one of the available communications

templates

Comms templates

Communication templates are available for most connected MoTeC devices.
When MoTeC releases new products, new communication templates will also

be released. These will be incorporated in the latest software versions. See
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Updating C127 Dash Manager Software on how to update to a new software
version to make the latest communication templates available.

Calculations

The Display Logger has special and user definable general purpose
calculations available. They are set up from the Calculations menu.

Special Calculations

e Lap Time and Number — click on the tabs to set up Lap Time, Lap
Speed, Running Lap Time, Split Lap Times, Lap Number, Laps
Remaining

e Speed and Distance — click on the tabs to set up Ground Speed, Drive
Speed, Wheel Slip, Lap Distance, Trip Distance, Odometer

e Lap Gain/Loss —to set up a continuous indication of how far behind or
ahead the vehicle is compared to a reference lap

e Gear Detection —to set up Current Gear

e Fuel Prediction — click on the tabs to set up Fuel Used, Fuel Usage,
Fuel Remaining, Laps Remaining, Fuel Used per Lap

e Speed Min/Max —to perform Min/Max Speed calculation (Peak/Trough
detection)

General Purpose Calculations

e Tables —to set up 2D and 3D Lookup Tables

e User Conditions — to activate items such as a Thermatic Fan or
Gearbox Oil Pump

e Counters — Set up to 10 counters. Counter value can be increment or
decremented based on the selected channel conditions.
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Functions

Data Logging (optional)

Data logging allows sensor readings and calculated values to be stored in the
Display Logger's memory for later analysis using the i2 Data Analysis
software.

To configure logging
e Onthe Functions menu, click Logging
e Select the relevant tabs to set up the logging parameters

Power

The Display Logger power can be turned off at any time without losing the
logged data, because it uses FLASH memory that does not require an internal
battery to keep it alive.

Logging Memory
The C127 has optional Data Logging upgrades providing 120 MB of logging
memory. See Display Logger Upgrades.

Start and Stop Logging Conditions

To avoid logging unnecessary data, logging can be started and stopped by
user definable conditions.

For example logging might start when the vehicle exceeds 50 km/h, and stop
when the engine RPM is below 500 rpm for 10 seconds.

The Display Logger provides the normal logging type; this will continuously
log data to memory whenever the Start Condition is true and the Stop
Condition is false.

Memory Usage

When the logging memory is full the Display Logger may be configured to
either stop logging, or to overwrite the oldest data, which ensures that the
most recent data is always available. This is referred to as cyclic logging.

For most applications it is recommended that cyclic logging is used.

Logging Time

The maximum logging time is dependent on the logging memory size, the
number of items logged and the rate at which they are logged. The Dash
Manager software will report the total available logging time.
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Logging Setup Files

The logging list can be saved and loaded from a file. This allows multiple
logging setups to be used.

Logging Rate

The logging rate sets how often each channel is logged and can be set
individually for each channel.

The rate at which the values are logged must be fast enough to record all
variations in the reading. If the value is logged too slowly, the readings can be
totally meaningless. For example, suspension position may need to be logged
at 200 times per second or more.

However, if a value is logged faster than necessary it will not improve the
accuracy of the logged data. It will just reduce the total logging time available.
For example, the engine temperature only needs to be logged at once per
second.

CAN Bus Bandwidth Limit

High logging rates also increase the amount of data that is being received
from the measurement devices, which increases the amount of data on the
CAN bus. This can lead to exceeding the CAN bus bandwidth limit. See
CAN Bus Bandwidth Limit.

Note: The Dash Manager software will warn if the bandwidth is likely to be
exceeded.

Maximum Logging Rate

The maximum logging rate is limited to the update rate of the particular
channel. This varies significantly depending on the source of the channel.
For example, some communications devices may only update at 50 Hz.
Also some internal calculations may be limited to 100 Hz.

Update Rate

Each input is measured at a maximum rate which is dependent on the
capabilities of the measuring device and may also vary between inputs on that
device. See Update Rate Summary.

Anti-Alias Filter

If a channel is logged at a rate slower than its specified update rate then an
optional anti-alias filter can be applied.

The anti-alias filter is used to average out any variations in the signal between
logged values. This ensures that unrepresentative values are not logged.
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The anti-alias filter is implemented by averaging the channel values between
logging events. For example, if a channel has an update rate of 1000 Hz and
it is logged at 100 Hz then the preceding 10 samples will be averaged each
time it is logged.

The anti-alias filter is normally turned on by default when a channel is added
to the logging list, but may be turned off if required. For normal purposes it is
recommended that the anti-alias filter is left turned on.

Note: For some channels the anti-alias filter cannot be turned on because the
averaging performed by the filter would cause incorrect values. This is the
case for on/off channels and channels where the bit values have a particular
meaning, for example error group channels.

Real Time Value (ADL2, SDL)

For channels that come from an ADL2 or an SDL, the logging anti-alias
filter also affects the real-time value of the channel. This is the value that
all other parts of the system see, such as the various calculations.

Note: The anti-alias filter is limited to 50 Hz for real time values even if the
channel is logged at a lower rate. For example, a channel logged at 10 Hz
will be filtered and updated at 10 Hz in the logging and 50 Hz for the real
time value.

Note: Channels that are not logged are updated at 50 Hz.

Real Time Value (For devices other than ADL2, SDL)

The real time value from other devices and from internal calculations is not
anti-aliased at the logging rate, however the value can be anti-aliased in
the logging.

Phase Shift

The anti-alias filter will cause a phase shift (time delay) of half the logging
rate. For example, a channel logged at 100 Hz is logged every 10
milliseconds, so it is delayed by 5 milliseconds.

For most purposes this time delay is not an issue.

Channels logged at the same rate are delayed by the same amount, which
negates this effect when comparing these channels.

This applies to all channels whether they are generated internally from a
calculation or whether they are generated externally from devices such as
a display device.
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Track Map

For the i2 Data Analysis software to plot a track map, either a GPS should be
connected or a number of separate sensors that will provide the required
information.

Track Map using GPS
Ensure GPS Latitude and GPS Longitude are logged.

Track Map using Sensors
The following sensors are required and must be logged:

Lateral G force (internal sensor)
Wheel Speed
Lap Beacon (the ‘Beacon’ Channel must be logged)

Optionally Longitudinal G force (internal sensor)

A Longitudinal G force sensor should be used if the vehicle has only
one wheel speed sensor. This allows the analysis software to eliminate
wheel lockups which is essential when creating or using a track map.
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Display Using Fixed Layouts

The C127 display is a high contrast, high brightness colour LCD display.

To configure fixed displays

1.
2.
3.

On the Functions menu, click Display.
Select the relevant Display type

Select the required mode (RACE, PRACTICE, WARMUP) by
selecting the relevant tab.
Select the required fixed display style by double-clicking on the fixed
display style displayed down the left side of the Edit Display Style
screen. On the right-hand side are controls to set the colour scheme
of the selected style.
Set the labels and channels you want to display for each of the
numeric display components (e.g. Number 1, Number 2, Gauge,
Bar 1 etc.). To do this:

a. Select the display component.

b. Select the Change button (alternatively, double click on the
relevant display component).

Display Setup @I

RACE | PRACTICE I WARMUP I Channels I Backlight I Display Creator Channels | Display Creator Settings |

Page Label : Display Style :
RACE Edit...
MNumber 1
=/9:99.99 QHEEEREEE) <99999>!
9:99.99 99.99 9:99.99
Gauge * Mumber 2 :
Engine RPM 0 to 8000, Shift 7500 | | Engine Temp (C) <99999>
Gear :
Gear <9=
Bar 1: Mumber 3 :
Running Lap Time (M:55.HH) «53.99>
Bar 2: Lap Time (M:55.HH) <59.99=

Bottom: (4,20 used)

1: Fuel Pres (kPa)

2: Bat Volts C185 (V)
3: Lambda 1 (LA)

4: Lap Number

5:

L

x

Eng Qil Temp {C)
Throttle Pos (angle:)
Lambda 2 (LA)

Change... | | Clear

Copy From...

Eng Qil Pres (kPa)
Manifold Pres (kPa)
Air Temp Inlet (C)

Reference Lap Time (M:55.HH)

|

<0099 999 9999
<099,9_99.9 9999
<09,93 9,99 9999
<0999 5099 >

Options...

Cancel | ‘ Help
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Display Modes (Pages)

The display has three display modes or pages; the default names are RACE,
PRACTICE and WARMUP. The mode is changed by pressing the button
assigned to this function.

The mode names can be changed to suit your individual needs; this is done
by double-clicking on the Page Label field.

RACE Page

The Race display is normally used to display minimal information, e.g. RPM,
Lap Time, Fuel Remaining or Laps Remaining.

PRACTICE Page

The Practice display is normally used to display basic information, plus
information to help the driver improve lap times, e.g. Lap Time, Lap

Gain/Loss, Maximum Straight Speed, Minimum Corner Speed or Corner Exit
Speed.

WARMUP Page

The Warm-up display is normally used to display important engine sensor
readings during engine warm-up, e.g. RPM, Battery Voltage, Engine
Temperature, Oil Pressure, Oil Temperature and Fuel Pressure.
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Bar 1 and Bar 2

The Bar 1 and Bar 2 facility provides the means to configure two bar type
graphs. One could most likely be configured to graphically represent the
current value of the Lap Gain/Loss Running channel as a Gain / Loss bar, the
other can be configured as any other useful indicator such as a battery
voltage, fuel, temperature or pressure gauge.

Two intermediate points can be set, see the battery voltage example below.
However, a gain/loss bar can only use the first intermediate point.

GAIN/LOSS
LOSS +1 m] i — G AIN -1

BATTERY VOLTS
= I = 15

Example Bar 1 (gain / loss bar) and Bar 2 (battery voltage gauge)

These bars can be customised to suit a user's preference. The properties for
these two examples are shown below.

5 ~
Bar 1 s o> (s
— — — — — o— o— o—
Settings Settings
Channel : Lap Gain/Loss Running Select... Channel : Bat volks C127 Select. ..
Unis : second (s} - Units ; valt () 4
Labels Lahels
Title ¢ GAINILOSS Title : BATTERY ¥OLTS
Left LOS5 +1 Left : 8
Right : AN -1 Right : 16
alues Values
Origin : Intermediate 1 - Qrigin Left b
Left 1.00 Left : .00
Colour 1 . —
| Intermediate 1: 0,00 coior 1: [ B | Intermediate 1: 13,00 = =)
o Colour 2 : —
Intermediate 2 : coourz: [l V] intermediate 2 : 15,00 5
Colour 3
Right : 1.00 Right : 16,00
Options Options
/| Show intermediate tick marks /| Show intermediate tick marks
Change whole bar colour Change whole bar colour

In the battery volts example, with the Change whole bar colour option not
selected, the three specific colours will display in the relative section of the bar
according to the channel value, as shown in the example.

If the Change whole bar colour option is selected, the whole bar colour will be
red if the channel value is from 8 to 13, green from 13 to 15 and red from 15

to 16.
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The bars can be customised to suit a user's preference. For example:
e Setting the scale and the time units.

e Customise the labels at either end of the bar. In the GAIN/LOSS example
above, LOSS +1 and GAIN -1 are used, where 1 is the scaling value.
Another label example could be LEFT and RIGHT.

e Invert colours.
e Specify the negative to the left or right.

Dial or Bar Graph (depending on style chosen)

n lN

A N§9:99.99

Example sweep bar

o 1 2 3 4 5 &

2PM X000

Example linear bar

The dial or bar graph has a user definable range and is typically used as a
tacho, however it can be used to display any other value.

A fully programmable shift point can be displayed, which can also be gear
dependent.
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Top Displays

99 99 99. 99 9: 99 99

RIGHT RIGHT

The numeric displays can be programmed to display any channel value.

The numeric displays can show any channel value plus up to two override
values. Override values display each time their value is updated. This is
useful for values that are updated periodically. The override values are shown
for a programmable period of time. For example, a numeric display could
normally show the Running Lap Time (which is continuously updating), then
be overwritten by the Lap Time for 10 seconds each time the Lap Time is
updated.

The label above each of the numeric displays can be changed to suit the
channel assigned.

Centre Display

The centre display is normally used to display the current gear but can be
used for other purposes.
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Bottom Display

NUMBER 1 NUMBER 4

[9:99. 99 99 99 9 9999}

—TE— e——rry
LEFT RIGHT RIGHT

At the bottom, up to 20 lines can be accommodated, with each line containing
up to 3 channel values at a time.

The label above each value can be changed to suit the channel assigned.
The 20 lines can be scrolled up or down using external buttons.

Similar to the top numeric displays, the bottom display can show up to four
override values.

Four Line Style

9:99.99 99.99 9:99.99

9:99.99 99.99 9:99.99
9:99.99 99.99 9:99.99
9:99.99 99.99 9:99.99

Where the four-line style is chosen, it shows four lines of values at a time, with
up to three values per line.

The 20 lines can be scrolled up or down, 4 lines at a time, using external
buttons.
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Alarm Displays

When an alarm is activated, a message is shown along the bottom of the
display until it is acknowledged. To draw the driver's attention to the display, it
is recommended to activate a warning light.

The message can be defined as required and can include the current sensor
reading or the sensor reading when the alarm was triggered.

245

NGINE TEMP.

102.4

Example active unacknowledged alarm
See the Alarms section for details on behaviour and operation of alarms.

Up to 6 active acknowledged alarms can be displayed in the Alarm Status
Panel along the bottom of the display, covering what was there before. By
default, the Alarm Status Panel display is OFF. This can be set ON by the
user. See Alarms for details about the Alarm Status Panel and its operation.

Below are examples of how active acknowledged alarms would be arranged.

ENGINE TEMP SESSION TIME || ENGINE TEMP SESSION TIME

81 0:09 |81 0:09
" "

OIL PRESSURE LAP NUMBER OIL PRESSURE LAP NUMBER

SPEED BATTERY SPEED BATTERY

121 6.8|121 .

AP OO0 RFM 000

RUNNING LAP TIME GAIN/LOSS LAST LAP TIME RUNNING LAP TIME GAIN/LOSS LAST LAP TIME

0:05.3  0.00 0:00.000:05.3 0.00 0:00.00

One Active Alarm Two Active Alarms

ENGINE TEMP SESSION TIME ENGINE TEMP SESSION TIME

81 0:09 81 0:09
" "

OIL PRESSURE LAP NUMBER || OIL PRESSURE LAP NUMBER

SPEED BATTERY SPEED BATTERY

121 ' @& - 6.8|1121 '@ "~ -

RUNNING LAP TIME GAIN/LOSS LAST LAP TIME RUNNING LAP TIME GAIN/LOSS LAST LAP TIME

0:05.3 0.00 0:00.000:05.3 0.00 0:00.00
WARNINGALARM 1.2345 WARNINGALARM 1.2345 M| WARNINGALARM 1.2345 WARNINGALARM 1.2345 WARNINGALARM 1.2345
WARNINGALARM 1.2345 WARNINGALARM 1.2345 [l WARNINGALARM 1.2345 WARNINGALARM 1.2345 WARNINGALARM 1.2345

ThreelFour Active Alarms Mare than Four Active Alarms
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Display Formatting
Units

All display units can be changed to suit the driver preferences, for example,
show temperatures in Fahrenheit rather than in Celsius.

Note: This is independent of the units used for other purposes.

Decimal Places

The number of decimal places can be reduced for display purposes, for
example, the engine temperature is measured to 0.1 °C but is better
displayed with no decimal places.
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Display Setup with Display Creator

When using Display Creator, communications and channels need to be set
up. To automate this, a DBC file is created when the Dash Manager
configuration is saved. This file can then be imported into Display Creator.

The Display Creator Channels and Display Creator Settings tabs are used to
set the definitions for creation of the DBC file. This file is then imported into
Display Creator to automate the communications and channels setup.

External Displays (Display Creator) with CAN

External displays created with Display Creator use CAN for messaging, the
following CAN values must be set:

e The CAN bus
e The address format
e The base address, or select the default.

A warning will display if any of the CAN settings conflict with existing CAN
configurations.

Display Creator Channels Tab

This tab is used to select the channels to include in the DBC file. The DBC file
is created when the configuration is saved.

The DBC file is imported by Display Creator to automate the setup of
communications and channels.

Note: Channels selected in the Display Creator Setting tab (see below) must
also be selected in this list for them to be included in the DBC file.

Display Creator Settings Tab

This tab is used to define page display behaviour.

Note: The channels selected on this tab must also be included in the Display
Creator Channels list (see above) for them to be included in the DBC file for
import to Display Creator.

Number of Pages

Specifies the number of pages defined in the applicable Display Creator
configuration.

Preserve Page

If ticked and the device is power cycled, the last page that was displayed for
at least five second before the power cycle occurred will display.

If not ticked and the device is power cycled, the default page will display.
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Page Channels
Specifies the channels used to set page up, down and reset values.

Page up is the next page in numeric sequence, default channel is Display
Page Up Button.

Page down is the previous page in numeric sequence; default channel is
Display Page Down Button.

Page reset returns the display to the default page; default channel is Display
Page Reset Button.

Output Channels

This is used to select the output channel, which is the channel that controls
the page displayed; default channel is Display Page.

Note: For page control to function, this channel should be included in the
Display Creator Channels list so that it is included in the DBC file for import to
Display Creator.

For example, if the output channel value is 3 (that is page 3 is displayed), it is
increased to 4 via the Display Page Up Button channel and decreased to 2 via
the Display Page Down Button channel.

Options Tab

This tab is used to select whether a DBC file should be generated, and if so,
its filename.

If the DBC file is to be generated, specify a filename or select the default, The
default syntax is: [name of the configuration]-[display name].dbc.



MoTeC Configuration 51

Alarms

Alarm Comparisons

The warning alarm limits are fully programmable and may include up to 6
comparisons to ensure that the alarms are only activated at the correct time.
For example, an engine temperature alarm may activate at 95 °C if the ground
speed has been above 50 km/h for 30 seconds. The speed comparison
avoids the alarm showing during a pit stop due to heat soak. Additionally
another comparison could be set at a higher temperature to cover all other
situations.

The comparison values can be automatically incremented or (decremented)
when an alarm occurs. For example the engine temperature alarm may be set
at 95 °C with and increment of 5 °C, so that the second time the alarm
activates at 100 °C. A limit may be set on the number of times the comparison
value is allowed to increment. An alarm may return to its original value after a
period of time, in case the alarm condition was temporary.

The alarms can be dependent on the current display mode page (Warm-up,
Practice or Race).

Alarm Behaviour
Alarms are either:
e Active and unacknowledged (alarm conditions are true).

e Inactive and unacknowledged (alarm condition was true but became
not true before alarm was acknowledged).
These will continue to display until acknowledged.

e Active and acknowledged (alarm conditions are true but not
displayed).

¢ Inactive (conditions needed to make an alarm active are not met or
true).

The following behaviour applies:

e Active and inactive unacknowledged alarms remain displayed until
they are acknowledged, either by the Acknowledge Button or
automatically after a defined period of time. After acknowledgement,
and if the alarm is still active, it may display again after the "do not
display message interval" has elapsed.

Note: If it appears that an active unacknowledged alarm cannot be
acknowledged (that is, it continues to display), it could be that the "Do
not display this message again until ... seconds have elapsed" is set
to zero.
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e If there is more than one unacknowledged alarm, the alarm with the
highest priority (that is, the alarm that is highest on the alarm list) is
displayed.

e |If there are a number of unacknowledged alarms, these will display in
priority sequence as each higher priority alarm is acknowledged.

Alarm Status Panel

Additionally an Alarm Status panel may be displayed which shows the current
state of up to 6 active acknowledged alarms. The panel is off by default and
may be turned on or off using the Alarm Acknowledge button when there are
no alarm messages displayed. If displayed, it will be obscured while there is
an unacknowledged alarm.

Below are four examples of the Alarm Status Panel.
U.Ub.5 U.ov U UU.UU | U.UD.5 U.uuv U 0u.uv

One Active Alarm Twe Active Alarms

V.UVJ).JD V.UV V.UV.VUV | V.VI.D V.UV V. Uuv.Uv
WARNINGALARM 1.2345 WARNINGALARM 1.2345 | WARNINGALARM 1.2345 WARNINGALARM 1.2345 WARNINGALARM 1.2345
WARNINGALARM 1.2345 WARNINGALARM 1.2345 | WwARNINGALARM 1.2345 WARNINGALARM 1.2345 WARNINGALARM 1.2345

Three/Four Active Alarms More than Four Active Alarms

Other Functions

The Display Logger can perform many other functions accessible from the
Functions menu including the following:

Shift Lights — to configure the shift point values for use with the Shift Lights.

Shift Light Module — to configure the C127 16 stage shift lights as well as an
additional MoTeC's SLM-C or SLM.
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Operation

When operating the C127, any of the activities of the Online menu of the
Display Logger Manager software can be performed. This requires the PC to
communicate to the Display Logger.

Note: All other menu items perform offline activities.

Retrieving the Logged Data

e Onthe Online menu, click Get Logged Data

A PC is used to unload the logged data from the Display Logger. The logged
data is then stored on the computer's hard disk.

After each unload the user has the option to clear the logging memory.

The unload may be interrupted part way through if necessary by
disconnecting the computer. The partial unload will contain the most recently
logged data and will be stored on the computer's hard disk. In this case the
Display Logger memory is not cleared and logging will continue as normal at
the end of the existing data. Next time the logged data is unloaded both the
new data and the previously partly unloaded data will be retrieved.

Sending and Retrieving Configuration Files

e On the Online menu, click Send Configuration to send the currently
open configuration file
Note: When a configuration file is sent to the Display Logger the
existing data is retrieved and stored in the From Dash Backups
directory to use in case the data in the Display Logger needs to be
restored. The maximum number of files is 10.

e On the Online menu, click Get Configuration to retrieve the current
configuration file.
This will only be necessary if the original file is not available on the PC.

Zeroing Sensors

Some sensors require regular zeroing, for example Steering Angle,
Suspension Position, Ride Heights, G Force Sensors and Throttle Position.
Dash Manager software provides a feature for easy zeroing of all these
Sensors.
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Checking Operation

Monitor Channels

The currently active channels can be monitored to check the operation of all
functions and measurements.

e On the Online menu, click Monitor Channels

e To show any channel on an oscilloscope style screen, click Utilities
and then Oscilloscope

Simulate

The Simulate feature allows most input channels to be manually changed so
that the Display Logger operation can be checked under abnormal conditions,
e.g. High Engine Temp. This is extremely useful for checking that the Display
Logger is working as expected.

e On the Online menu, click Simulate

Test

A number of tests are provided to check the operation of the Display Logger,
such as the Display test.

e On the Online menu click the appropriate test

Configuration Versions and Updating

e On the Online menu, click Upgrade Dash Version

The software inside the Display Logger (firmware) can be updated by the user
at any time to take advantage of the latest features.

Matching Versions

The firmware version must match the version of the Dash Manager software
on the PC in order to communicate. Dash Manager will show a warning if the
versions do not match.

Tip:

To check the version of Dash Manager, click About MoTeC C127 Dash
Manager on the Help menu.

The firmware version is displayed on the bottom line of the display for two
seconds when the Display Logger is powered.

Matching Configuration File

The configuration file must also match the software and firmware versions
used. The display will show a warning if the file does not match.
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Configuration files can be updated by choosing the option to automatically
update the configuration file while updating the software (firmware). It can
also be done manually by upgrading the configuration file and sending it to
the Display Logger:

e On the File menu, click Open

¢ Inthe Files of type box select the new version file extension.
The file will be converted to the new version format and saved with the
same file name but with the new version file extension.
Note: The old file is not changed.

e On the Online menu, click Send Configuration to send the
configuration file to the Display Logger

Upgrading the Display Logger

Several options are available as upgrades to customise and grow your
system.

The currently enabled options can be listed and new options can be activated
through a password acquired from MoTeC.

To Upgrade the Display Logger
e On the Online menu, click Enable Dash Options

Password Protection

e On the Online menu, click Set Access Passwords

Several Display Logger capabilities can be protected from unauthorised
access by using the password protection.

Note: Ensure you keep passwords secure. The unit needs to be returned to
MoTeC for unlocking if the passwords are lost.

Other Online Activities

Many other activities are accessible from the Online menu including the
following:

Reference Lap —to send a reference lap to the Display Logger used in the lap
gain/loss system.

View — to view:

0 saved details e.g. Running Totals

o0 Device Halt Counts
Communication — to list the current Connections Settings
Miscellaneous
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0 Erase Logged Data without unloading

o Serial Number to view the Serial and Hardware Number;
the Serial Number is required when ordering upgrade passwords, the
Hardware Number is for MoTeC internal use

o0 Change Display Mode to switch between Practice, Warm-up and
Race mode
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Appendices

Specifications

Specifications listed as optional are available as upgrades to customise and
grow your system. These additional features are activated through a simple
password system, at any time when you need it.

An overview of the upgrades can be found in Display Logger Upgrades.

Logging

Optional 120 MB logging memory

Logging rates up to 500 samples per second
Fast Ethernet download

Includes i2 Standard data analysis software

Display
Type: 7" colour TFT LCD, anti-reflective
Resolution: 800 x 480, anti-aliased graphics

Layouts: diverse selection of configurable fixed layouts, or purchase Display
Creator to create user designed and configured layouts

48 user-defined, scrollable message lines with programmable overrides
3 programmable modes with customisable labels

Inputs — (requires I/O Upgrade Option)
6 x Analogue voltage inputs
e 4x0t05.46V, 1.33mV resolution
e 2x0to15.0V, 3.66 mV resolution
2 x Analogue temperature inputs
e 2x0to 15V, 3.66 mV resolution
2 x Digital inputs (provided, does not require 1/0 Upgrade)
3 x Speed inputs (provided, does not require 1/O Upgrade)

Outputs — (requires 1/0O Upgrade Option)
4 low side outputs PWM or switched operation
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Expanders

Compatible with up to two E888 and E816 expanders (providing full functional
use)

Internal Sensors

3-axis accelerometer, detection range: +/- 5G
Dash temperature sensor

Sensor supply voltage

Battery voltage

Communications

2 configurable CAN buses, with individually programmable CAN bus speeds.
One can be used as RS232 Receive:

e Maximum data range 1 Mbit/sec

e Recommended terminating impedance 100 ohm

e Configurable as either CAN or RS232
2 RS232 ports, one with transmit and receive, one with receive only
1 LIN port

Power Supply
Operating voltage: 6 to 32 V DC

Operating current: 0.8 ampere typical at 14 V (at full brightness, excluding
sensor currents)

Reverse Battery protection
Battery Transient protection

Operating Temperature

Internal: -20 °C to 80 °C (above 60 °C maximum backlight brightness
progressively reduced)

Typical ambient temperature range in free air: -20 to 60 °C

Sensor Supply Current

5V Sensor supply: 0.25 ampere maximum
8 V Sensor supply: 0.25 ampere maximum
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Ingress Protection (IP) Rating

IP 67 - Dust tight, protected against water immersion (up to 30 min
submersion to depth of at least 15 cm)

Note: IP rating is dependent upon the user ensuring that connector wire
entries are waterproof, which as a minimum, requires all unused wire cavities
on the connector to be plugged.

Physical

Size: 196.2 x 122.5 x 24.9 mm excluding connector
Weight 615 g

1 x 34 pin waterproof connector
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Display Logger Upgrades

For the C127 Display Logger the following upgrades are available:

C127 120 MB Logging (part 29818)

Allows recording of all input data to a 120 MB internal logging memory,
includes i2 Standard data analysis software.

C127 Pro Analysis (part 29820)

Upgrade from the i2 Standard version that is supplied as standard with the
data logging upgrade.

C127 1/O (part 29800)

Allows use and configuration of extra inputs and outputs consisting of:
6 analogue voltage inputs

2 analogue temperature inputs

4 auxiliary outputs.

C127 Display Creator (part 29816)
Allows the user to create fully configurable custom layouts.
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Characteristics

Input Characteristics

Analogue Voltage Inputs

Suitable for Potentiometers

Voltage output sensors

Variable resistance sensors with pull-up
resistor

Measure Voltage Range Inputs 1-4: 0 to 5.46 V

Inputs 5-6: 0 to 15.00 V

Note: Voltages outside this range may affect
the readings on other inputs.

Input Resistance 100k ohms to O V
Resolution Inputs: 1.33 mV
Measurement Methods Ratiometric
Absolute
Variable Resistance Off/On
Update Rate 1000 times/second
Filter 240 Hz 1st order
Calibration Accuracy Gain 0.05% max (Ratiometric method)

Gain 0.15% max (Absolute method)
Offset £ 6 mV max

Linearity + 6 mV max

Temperature Stability 60 ppm/°C max
Calibration Schedule 12 months
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Analogue Temp Inputs

Suitable for 2 wire variable resistance sensors and some
voltage output sensors

Measure Voltage Range Oto15.0V
Note: Voltages outside this range may affect
the readings on other inputs.

Input Resistance 1000 ohms pull-up to 5V sensor supply
+100kto OV
Resolution 3.66 mV
Measurement Methods Ratiometric
Absolute
Variable Resistance
Off/On
Update Rate 1000 times / second
Filter 290 Hz 1% order
Calibration Accuracy Gain: 0.05% max (Ratiometric method) Gain:

0.15% max (Absolute method)

Offset: £ 6 mV max

Linearity: + 6 mV max

Temperature Stability: 60 ppm/°C max
Calibration Schedule: 12 months
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Digital Inputs

Suitable for

Switch to 0 V
Logic signal and open collector device (e.g. Hall
Switch)

Pull-up Resistor

2200 ohmsto 3.3V

Voltage Range Oto 15V
Positive Trigger

Threshold 2.4V max
Negative Threshold 0.6 V min
Hysteresis 0.4V min

Update Rate

100 times / second

Filter Time Constant

22 usec

Measurement Methods

Frequency

Resolution 0.1 Hz

Maximum Frequency 3200 Hz
Rising Edge Triggered

Period 1 usec

Measures period between rising edges
Resolution 1 usec

Maximum 32 msec

Period 100 usec

Measures period between rising edges
Resolution 100 usec

Maximum 3.2 sec

Pulse Width 1 usec
Measures pulse low time
Resolution 1 usec
Maximum 32 msec

Pulse Width 100 usec
Measures pulse low time
Resolution 100 usec
Maximum 3.2 sec
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Speed Inputs

Hall mode A 2200 ohm pull-up resistor is connected to 2.7 V
Suitable for Switch to 0 V
Logic signal
Open collector device (e.g. Hall Switch)
Pull-up Resistor 2200 ohmsto 2.7V
Voltage Range Oto 15V

Trigger Threshold Selectable between -1.33 V and 4.68 V

Magnetic mode The pull-up resistor is disengaged and the trigger
levels can be varied depending on the input
frequency

Suitable for Two wire magnetic sensor (variable reluctance
sensor)

Input Resistance 100k ohms to ground (no pull-up)

Voltage Range -80 Vto +80 V

Programmable -1.33Vt04.68V

Trigger Levels

For both modes

Update Rate 100 times / second

Filter Time Constant |25 usec

Hysteresis 0.17 V min
Measurement Frequency
Methods Resolution 0.1 Hz

Maximum Frequency 3200 Hz
Falling Edge Triggered

Period 1 usec

Measures period between falling edges
Resolution 1 usec

Maximum 32 msec
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Period 100 usec

Measures period between falling edges
Resolution 100 usec

Maximum 3.2 sec

Pulse Width 1 usec
Measures pulse high time
Resolution 1 usec
Maximum 32 msec

Pulse Width 100 usec
Measures pulse high time
Resolution 100 usec
Maximum 3.2 sec
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MoTeC

Analogue Input Sampling
4 times oversampling is scheduled with samples taken every 250 usec,

providing measurements every 1 msec.

The following inputs are sampled at 250 usec, with microsecond offsets as
shown in the table:

Offsets 0.0 usec |+1.5 usec
0.0usec |(AT1 AVl
+9.3 usec |AT2 AV2
+20.9 usec |N/A AV3
+30.1usec |N/A AV4
+39.4 usec |N/A AV5
+51.0 usec |N/A AV6
+81.1usec |N/A INTTEMP
+90.4 usec |8VSEN |SPD1
+102.0 usec |5VSEN |SPD2
+111.3 usec |GLAT SPD3
+122.9 usec |GVERT
+132.1 usec |GLONG |N/A
+141.4 usec |N/A BAT+

Output Characteristics

Output Type

Open Collector (drives to ground) with weak pull-up (10
kQ) to battery positive

Current

0.5 A max, current limited and thermal overload protected

Output Clamp

70 V Flyback Clamp (no clamp diode to supply)
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C127 Pin List by Pin Number

Pin Name Function

1 E-TX- Ethernet Transmit -

2 E-TX+ Ethernet Transmit +

3 AV1 Analogue Voltage Input 1
4 AV2 Analogue Voltage Input 2
5 AV3 Analogue Voltage Input 3
6 AV4 Analogue Voltage Input 4
7 8Vv Sensor 8 V

8 5V Sensor 5V

9 Ov Sensor 0 V Analogue Volt & Analogue Temp
10 E-RX- Ethernet Receive -

11 E-RX+ Ethernet Receive +

12 AV5 Analogue Voltage Input 5
13 AV6 Analogue Voltage Input 6
14 DIG1 Digital Input 1

15 DIG2 Digital Input 2

16 AT1 Analogue Temp Input 1
17 AT2 Analogue Temp Input 2
18 CAN1L CANL1 Lo

19 CAN1H CAN1 Hi

20 RS232-1 TX RS232-1 Transmit Output
21 SPD1 Speed Input 1

22 SPD2 Speed Input 2

23 SPD3 Speed Input 3

24 VID1 Video Input 1

25 RS232-2 RX RS232-2 Receive Input
26 CAN2L CAN2 Lo / RS232 Ground Input
27 CAN2H CAN2 Hi/ RS232 Receive Input
28 RS232-1 RX RS232-1 Receive Input
29 AUX1 Auxiliary Output 1

30 AUX2 Auxiliary Output 2

31 AUX3 Auxiliary Output 3

32 AUX4 / LIN Auxiliary Output 4 / LIN
33 BAT+ Battery Positive

34 BAT- Battery Negative
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MoTeC

C127 Pin List by Function

Pin | Name

Function

Battery Power

34 | BAT-

Battery Negative

33 | BAT+

Battery Positive

Analogue Voltage Inputs

3 AV1 Analogue Voltage Input 1
4 AV2 Analogue Voltage Input 2
5 AV3 Analogue Voltage Input 3
6 AV4 Analogue Voltage Input 4
12 | AV5 Analogue Voltage Input 5
13 | AV6 Analogue Voltage Input 6

Analogue Temp Inputs

16 | ATl Analogue Temp Input 1
17 | AT2 Analogue Temp Input 2
Digital Inputs

14 | DIG1 Digital Input 1

15 | DIG2 Digital Input 2

Speed Inputs

21 | SPD1 Speed Input 1
22 | SPD2 Speed Input 2
23 | SPD3 Speed Input 3

Auxiliary Outputs

29 | AUX1 Auxiliary Output 1
30 | AUX2 Auxiliary Output 2
31 | AUX3 Auxiliary Output 3
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Pin | Name Function

32 | AUX4/LIN Auxiliary Output 4 / LIN

8 V Sensor

7 8Vv Sensor 8 V

5V Sensor

8 5V Sensor 5V

0V Sensor

9 ov Sensor 0 V

CAN Interface

19 CAN1H CAN 1 High

18 | CAN1L CAN 1 Low

27 CANZH CAN 2 High / RS232 Receive Input
26 | CAN2L CAN 2 Low / RS232 Ground Input
Ethernet

10 | E-RX- Ethernet Receive -

11 | E-RX+ Ethernet Receive +

1 E-TX- Ethernet Transmit -

2 E-TX+ Ethernet Transmit +

RS232

28 RS232-1 RX | RS232-1 Receive Input

20 RS232-1 TX | RS232-1 Transmit Output

25 RS232-2 RX | RS232-2 Receive Input

Video Input

24 | VID1 Video Input 1
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Mounting Dimensions

196.2 407 y i 143.0
354 rR412.0
249 |
—— — S i _
— DOOOD00000 "'-..,_%‘ I e - Re
1255 L
O -
5
i1_'7‘.5
15 Maunting studs (3x) /
Note:

e All dimensions in [mm]
e Ensure product is not stressed when mounted

e Dimensions indicate actual product size, allow for clearance when
mounting
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Wiring

This section provides reference material about the Display Logger's connector
and wiring requirements.

Connector

Cl27connector

34 pin connector

Mating connector

34 pin AMP connector #65044

Wire Specification

Wire

Wire to suit Display Logger connector: 22# Tefzel, Mil Spec : M22759/16-22

M22759/16 Wire Ratings (for various wire gauges)
Insulation Material: Tefzel
Conductor: Tin Plated Copper
Voltage Rating: 600 V
Maximum Temperature: 150 °C

Wire Gauge |Cross Max Current |Resistance |Resistance

[AWG] Sectional Area |at 100 °C [ohm/m] [ohm / 1000 ft]
[mm2] Ambient [A]

22 0.38 5 0.045 14.0

20 0.61 6 0.028 8.5

18 0.96 9 0.018 5.5

16 1.2 12 0.014 4.3

14 1.9 18 0.009 2.7

12 3.0 24 0.006 1.8

Wire Stripping Tool
Recommended: Ideal Industries 45-2133 stripping tool with LB1195 wire stop.
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PC Connection

Ethernet Wiring Schematic:

CDL3/C125/C127 Ethernet Connector

Pin Function Pin Function

11 Ethernet RX+ 1 Ethernet TX+

10 Ethernet RX— 2 Ethernet TX—

2 Ethernet TX+ 3 Ethernet RX+
Ethernet TX— 6 Ethernet RX—

Pin numbering
12345678

e

s

87654321

Plug Socket
Wire

CAT5 UTP Ethernet cable
Cable

An Ethernet RJ45 socket, connecting to a standard Ethernet cable, is
provided on:

o #62204 C125 Race Loom Terminated (used on both C125 and C127)
e #61131 Ethernet cable, unterminated, 2 metre
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CAN Bus Wiring Requirements

The CAN bus should consist of a twisted pair trunk with 100R (0.25 watt)
terminating resistors at each end.

o0 If the CAN bus is less than 2 metres (7 ft) long, a single termination
resistor may be used.

e The preferred cable for the trunk is 100R data cable.

e The maximum length of the bus is 16 metres (50 ft)

e CAN devices (such as MoTeC Display Loggers, ECUs etc.) may be
connected to the trunk with up to 500 mm (20 in) of twisted wire.

'Hundred series'
C125 or C127 ECU

CAN-HI CAN-HI
CAN-LO CAN-LO

|100R|

IHOOLI

LTC| [BR2| |E888 CANHI
| CAN-LO

Input/ Other
Outputs CAN device

Lambda sensor
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C127 Display Logger to ECU wiring (RS232)

The following details the methods for connecting the Data Logger to various
MoTeC ECUs via RS232. In all cases this is done using the serial data stream
generated by the Telemetry function of each ECU.

In the case of the M800, M880 and M4e the Data Logger may be directly
wired to the ECU because these ECUs use RS232 interface levels. On the
M48, M4 (pre M4e) and the M8, a Computer Interface Module (CIM) or a PCI
cable is required to convert the signals to RS232.

M4e
Data
D9 Serial = Logger
Connector 5 25
3 23
= 51 Mde ECU
Note:

o Older M4 ECUs require a different connection method

e The data to the Display Logger will be interrupted while a PC is
connected.

M48, M4 (pre M4e) and M8

The M48, M8 and M4 (pre M4e) require the use of a CIM module or a PCI
Cable to convert the logic level signals used by these ECUs into RS232
levels.

Using a CIM Module

12 Data
HX
CIM Logger
M4/ M4B / M8
ECU
D8 Serial
Connector

Contact MoTeC for the CIM module drawing for full wiring details.
Note:

e The data stream to the Display Logger will be interrupted while a PC is
connected.
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C125 Race Loom Terminated Wiring (part 62204)

This loom is used on both the C125 and C127.

34 Pin Tyco
cDL3C
CO"”eCtg’ 0V 229 Black —
14 DIG1 22g Orange B2 |"B"
15 DIG2 22g Yellow B3 DTMEM
21 SPD1 22g Violet B4 |Button
2 SPD2 22g Brown pe |
o3 SPD3 22g Grey B6
RS232RX 22g Blue W
gg RS232TX 229 Pink E; DETM a
26 CAN-LO2 22g Green Ez  |ecu
57 CAN-HI2 22g White E4  |Connector
BAT- 22g Black oI g
CAN-LO1 22g Green
o  CAN-HIT 229 White |02 | PTM6F
BAT+ 220 Red C3 |Accessory
C4  |Connector
C5
100R C6
BAT- 22g Black a1 "G
o5 RX2 22g White G2 |pTm4F
G3 |GPS
8 SENSOR 5V 22g Red G4 |connector
10|.ETH_BX- orange >
11 ETH_RX+ orange/white 1
ETH_TX-
i | green
5 ETH TX+ green/white g cable
BAT- 22g Black f
34 Unterminated
33 BAT+ 229 Red Power

RJ45 Ethernet
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Update Rate Summary

Device Input Type Maximum Update
Rate (per second)
ADL3 Analogue Voltage Inputs 1000
ADL3 Analogue Temperature Inputs 1000
ADL3 Digital Inputs and Speed Inputs 100
ADL3 RS232 and CAN Communications |50 max *
ADL3 CAN comms fast receive 1000
ACL RS232 Communications 200 *
ACL General CAN communications 200 *
CDL3/C125/C127 |Analogue Voltage Inputs 500
CDL3/C125/C127 |Analogue Temperature Inputs 500
CDL3/C125/C127 |Digital Inputs and Speed Inputs 100
CDL3/C125/C127 |RS232 and CAN Communications |50 max *
CDL3/C125/C127 [CAN comms fast receive 500
VIM AV Fast Inputs 5000
VIM AV Differential Voltage Inputs 1000
VIM AV High Resolution Inputs 500
VIM AV Special Inputs 2000
VIM Speed Inputs 100
ADLISDL |anenie Notage lpute 1oy 1ove
ADL2/SDL Other Analogue Voltage Inputs 500
ADL2/SDL Analogue Temperature Inputs 500
ADL2/SDL Lambda Inputs 100
ADL2/SDL Digital & Speed Inputs 100
SDL Internal G Sensors 100
e L pevie) 190750
asmaio |arelogue Votage & Dl s [a0o 50
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* RS232 and general CAN communications update rate depends on how
frequently the data is sent from the device. Typically the update rate from an
M4, M48, M8 or M800 ECU is about 20 times per second using RS232 and
about 50 times per second for the M800 and M84 using CAN.
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Command Line

Usage:
Clubdash3.exe -c[connection] -d -x -l -e -t -s [config file name]

[config file name]

(Optional)

Fully qualified path to the configuration file.

(eg "c:\motec\dash\config\bathurst.d30")

Note: the path must included the file extension (e.g. .d30)

Options :

Each of the following options can be given as "/[character]" or "-
[character]". They are shown here as "-[character]".

-c[Connection Name]

(Optional)

Select a preconfigured connection by name as configured in the dash
connections dialog.

(e.g. -c"Primary CAN Connection™).
Note: There must not be a space between the ¢ and the connection name.

-d

(Optional)

Causes the debug console to be displayed.
Only available for debug builds.

-X
(Optional)

Causes the app to terminate when one the following tasks has been
performed.
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Tasks :
One or more of the following may be specified.

-l
(Optional)
Perform a “Get Logged Data” operation.

-e
(Optional)
Perform a “Get Engine Log” operation.

-t
(Optional)
Perform a “Get Tell-tale Values” operation.

P
(Optional)
Perform a “Print Summary” operation.

Note: The configuration file must be specified using a fully qualified path
including the file extension.

(e.g. -p "c:\motec\dash\config\bathurst.d30")
Note: There must be a space between -p and configuration file name.

-S
(Optional)
Perform a “Send Configuration” operation.

Note: The configuration file must be specified using a fully qualified path
including the file extension.

(e.g. -s "c:\motec\dash\config\bathurst.d30")
Note: There must be a space between -s and configuration file name.

-u
(Optional)
Perform an “Upgrade Dash Version” operation.
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CAN Bus Bandwidth Limit

The total available CAN bandwidth on a single CAN bus is 1 Mbit/sec.

The bandwidth used by the total of all devices on a particular CAN bus must
not exceed approximately 90% of this value (900000 bits/second)

If the total bandwidth required exceeds this specification then some devices
should be connected to the second CAN bus.

Note: Dash Manager will warn if the bandwidth is likely to be exceeded.

E888
Device on first CAN Address: Bandwidth = 145000 (bits/sec)
Device on second CAN Address: Bandwidth = 55000 (bits/sec)

Other Devices

Device Bandwidth

BR2, SLM, PLM Negligible

SDL, ADL2, MDD, M800 ECU TBD
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Comms Error Codes

The "Comms CAN x Diagnostic" and "Comms RS232 Diagnostic" channels
can be used to diagnose communications problems.

Multiple errors are shown by error codes added together. For example:
A RS232 error of 9 = parity + overrun.

The error values have the following definitions:

RS232 Errors
Errors generated by RS232 communications.

1 PARITY Parity bit incorrect. The comms parity setup is
wrong, or there is electrical interference causing
errors in the data.

2 FRAMING Not seeing the stop bit. The baud rate or stop
bit setup is wrong or there is electrical
interference causing errors in the data.

4 NOISE Glitch in the data. Electrical interference is
causing glitches in the signal. (the Display
Logger does not generate this error)

8 OVERRUN A byte was received before the previous byte
was read indicating that the processor was too
busy to read the message.

512 NO DATA A valid message header was not found - either
there is a wiring fault or comms is setup
incorrectly.

1024 CHECKSUM A valid message header was found, but the

checksum was wrong. If seen in combination
with other errors there is electrical noise. If only
checksum errors occur there may be a
software incompatibility between the Display
Logger and the other device.

2048 WRONG DATA  Could not decode the protocol.
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General CAN Errors
Errors generated by general CAN communications.

2

256

512

1024

2048

4096

8192

16384

FRAMING

OVERRUN

BAD CONFIG

NO DATA

CHECKSUM

WRONG DATA

BUS WARNING

BUS OFF

CAN TRANSMIT

Only generated when used with an
EBB88/E816 expander. Inconsistent message
length.

Receive or transmit overrun error. In the
receive case a byte was received before the
previous byte was read indicating that the
processor is too busy to read the message.
In the transmit case the transmit buffer is full
which could happen if the CAN bus is too
busy.

The device configuration is not valid (e.qg.
overlapping CAN addresses)

A valid message header was not found -
either there is a wiring fault or comms is
setup incorrectly, (problem could be at either
end), e.g. transmit and receive CAN IDs do
not match.

Only generated when used with an Async
Expander. See RS232 Errors.

Only generated when used with an Async
Expander or E888/E816 Expander. Async
Expander: Could not decode the protocol.
E888/E816: Compound ID incorrect.

More than 96 errors have occurred on the
CAN bus. Check wiring and termination
resistors. The CAN bus may still be
operational.

More than 255 errors have occurred on the
CAN bus. CAN communications is
suspended when this error occurs. Check
wiring, termination resistors and the CAN
baud rate. Also check that CAN HI and CAN
LO are correct (not swapped).

CAN bus transmit warning
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"VIMCOM" Errors

Errors generated by "VIMCOM" devices (SVIM, Display Loggers).
Note: VIMCOM devices are connected via CAN.

Display Logger Errors (C127)

These errors are generated by the Display Logger's communications

system.
2 FRAMING
256 BAD CONFIG

512 NO DATA

2048 WRONG DATA
4096 BUS WARNING

8192 BUS OFF

VIMCOM Device Errors.

Incorrect number of samples received.

Configuration mismatch between
Display Logger and device. Resend the
configuration.

VIMCOM packets have not been found.
Either there is a wiring fault or Display
Logger Connections is setup incorrectly.

VIMCOM packet has bad length.

More than 96 errors have occurred on
the CAN bus. Check wiring and
termination resistors. The CAN bus may
still be operational.

More than 255 errors have occurred on
the CAN bus. CAN communications is
suspended when this error occurs. Check
wiring, termination resistors and the CAN
baud rate. Also check that CAN HI and
CAN LO are correct (not swapped).

These error codes are sent once by the VIMCOM device on resuming data
transmission and therefore indicate why data was previously not being

transmitted.
4097 STARTUP

4098 HALT

4099 OVERRUN

Device has restarted (normally due to
power up). Data is not sent until sync is
achieved.

Data not sent due to deliberate halt. For
example configuration or firmware being
sent.

Data not sent due to transmit buffer
overrun (possibly due to CAN bus too
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busy)

4100 SYNC TIMEOUT  Data not sent due to Display Logger
sync message timeout (sync not
received from Display Logger)

4101 CAN ERROR Data not sent due to error on CAN bus
4102 SYNC Data not sent due to excessive sync error
EXCEEDED (synchronisation too far out)

Windows Keyboard Shortcuts

When using a laptop in and around a car, it is often not practical to use a
mouse to navigate through the program.

Using the keyboard to select options is easier.

Main Menu

MoTeC Dash Manager EI@
Eile Connections Calculations Functions  Online  Tocols Help
FEHEvaIrel e oEg ¥ e MoTeC

To access the main menu, press ALT + the key for the underlined letter in the
menu, followed by the underlined letter of the item in the drop down menu,
e.g. ALT + F, N for File New.

Alternatively press and release ALT, select the desired menu item using the
arrow keys, press ENTER to activate it.

Closing a Window

Press ENTER for OK or Close (only when the OK or Close button has a bold
line around it)

Press ESC to Cancel or Close

Getting Help
Press F1 to get help on the current window or item
Select Help from the Main Menu to access the main help system.
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Selecting an Item in a Window

Change Alarm x|

Conditionsl Message “pions I

—Acknowledgement
Remove message | v F\_u%natically, after |1'j seconds

or when acknowledge button is pressed

Do nat display this message again until IISD seconds have elapsed,

Warning Light
{” Do not activake ight Ackivate light {* Flash light

roukput Channel

Select, .. |

Ok, I Cancel | Help |

To access the various items in a window, press ALT + the key for the
underlined letter of the item of interest, e.g. to select the ‘Elash Light’ item
press ALT + F

Alternatively use the TAB key to move through the dialog box (use SHIFT +
TAB to move backwards). The selected control is usually indicated by a
dotted line around it, or by highlighting the text or item selected within the
control.

Using the Selected Item

The method of using the selected item (or control) depends on the type of
control. The common controls are detailed below:

Command Button

Select. .. |

Command buttons are generally used to show another screen or perform a
particular function.

Press ALT + the key for the underlined letter (S), or use the TAB key to
navigate to the command button. To select, press ENTER or SPACEBAR.
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Check Box
During these modes ¥ Race [~ Practice [v ﬂarmUp

A check box is used to tick on or off a particular option.

Press ALT + the key for the underlined letter (E), or use the TAB key to
navigate to the Check Box. To select, press SPACEBAR.

Group Box

arning Light
" Donot ackivake ight % Ackivate light ™ Elash light

The Group box is used to select an item from a group of options.

Press ALT + the key for the underlined letter (E, A or D), or use the TAB
key to navigate to the Group box. To select, use the arrow keys.

Text Box

essage
Texk Hi Eng Temp

A text box is used to enter a value or text.

Press ALT + the key for the underlined letter (M) or use the TAB key to
navigate to the Text box, type in the new value or text. Use BACKSPACE
or DELETE to remove unwanted characters.
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Channel : & Force Long

Rate :

ance)second
bwicesecond

5 kimes/second
10 times)second
25 kimes second
5[ Firnessecond
100 timesfsecond
200 timesfsecond
250 timesfsecond
500 times/second
1000 times)second

A list is used to select from a number of options.

Press ALT + the key for the underlined letter (M) or use the TAB key to
navigate to the List Box. To select, use the arrow keys.

Drop-down List Box

A Drop-down list box is used to select from a number of items, but only the
selected item is shown until a new item needs to be selected.

Press ALT + the key for the underlined letter (L) or use the TAB key to
navigate to the Drop down List Box. To select the desired item, use the
arrow keys, and press ENTER to close the list.

Tabs

Tabs are used to select the different tab pages of a screen.

To select the next tab, press CTRL + TAB. To select the previous tab,
press CTRL + SHIFT +TAB.
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Engine Sensors -
Zar Sensors

=-[7 Eike Sensors

t Boat Sensars

Drag Racing

E|El Miscellaneous Sensars

----- ABS

----- Ambient

----- Beacaon

----- Compass

-] Device Temperatures
----- Drriver

=[] Electrics

= Battery Wolts ECU
= Eat Yolts Logoger
o TN

=l

A Tree Structure is used to select items from a hierarchical list
The UP ARROW key moves the cursor up (selects the item above)
The DOWN ARROW key moves the cursor down (selects the item below)

The RIGHT ARROW key expands; expandable branches indicated by a
plus sign (+)

The LEFT ARROW key collapses; collapsible branches indicated by a
minus sign (-)

Screen Cleaning

Gently wipe using a clean water dampened microfibre cloth, followed by a
clean dry microfibre cloth.
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Glossary

MoTeC Devices

Plug-In

ECU for direct replacement of a factory ECU

ACL Advanced Central Logger

ADL2 Advanced Display Logger - second generation

ADL3 Advanced Display Logger - third generation

BR2 Beacon Receiver

BTX Beacon Transmitter

CiM Computer Interface Module

CLS Central Logging System

C125 Colour Display Logger

C127 7" Colour Display Logger

C185 Colour Display Logger

C187 7" Colour Display Logger

CDL3 Club Display Logger

DBwW4 Drive By Wire expander

E816 Input/Output Expander

E888 Input/Output Expander

i2 MoTeC data analysis software

i2 Pro MoTeC data analysis software, professional version

IEX Ignition Expander

LTC Lambda to CAN module

LTCD Lambda to CAN Dual module

M2R ECU dedicated to run 2 rotor engines

M4 ECU for engines with up to 4 cylinders or up to 2 rotors

M400 ECU for modern engines with up to 4 cylinders or up to 2 rotors
M48 ECU for engines with up to 8 cylinders and 2 rotors

M600 ECU for modern engines with up to 6 cylinders or up to 3 rotors
M800 ECU for modern engines with up to 12 cylinders or up to 4 rotors
M800
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M880 ECU for modern engines with up to 12 cylinders or up to 4 rotors
MDC Mitsubishi Diff Controller

MDD Mini Digital Display

MLS ECU dedicated to run Chevrolet LS1 and Lexus/Toyota V8s
PCI Cable |PC Interface cable

PDM15 Power Distribution Module with 15 outputs

PDM16 Power Distribution Module with 16 outputs

PDM30 Power Distribution Module with 30 outputs

PDM32 Power Distribution Module with 32 outputs

PLM Professional Lambda Meter

RTC Real Time Clock

SDC Subaru Diff Controller

SDL Sport Display Logger

SDL3 Sport Display Logger — second generation

SGA Strain Gauge Amplifier

SLM Shift Light Module

SLM-C Shift Light Module — Club version

SuUuU Software Update Unit

TCM Traction Control Module

VIM Versatile Input Module

Other

Caltration e o e ca el o pysica
CAN Controller Area Network - communication protocol

CDI Capacitive Discharge Ignition

ECU Engine Control Unit

GPS Global Position System

MAF Mass Air Flow

MAP Manifold Absolute Pressure

PID Proportional, Integral and Derivative gain

PWM Pulse Width Modulated
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RPM Revolutions Per Minute

RS232 Recommended Standard 232, communication protocol

RX Receive

TDC Top Dead Centre

X

Transmit
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